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Preface

Scope of Manual

This manual describes the RedHawk Architect™, an easy-to-use GUI interface for
creating and maintaining a runtime and devel opment environment for a single board
computer (SBC).

Structure of Manual

This manual consists of:

* Chapter 1, which introduces you to RedHawk Architect and guides you
through its use.

* An Index containing an alphabetical reference to key terms and concepts
and the pages where they occur in the text.

Syntax Notation

The following notation is used throughout this manual:

italic Books, reference cards, and items that the user must specify appear in
italic type. Special terms may also appear initalic.

list bold User input appearsin 1ist bold type and must be entered exactly
as shown. Names of directories, files, commands, options and man
page references also appear in 1ist bold type.

list Operating system and program output such as prompts, messages and
listings of files and programs appearsin 1ist type.

[1 Brackets enclose command options and arguments that are optional.
You do not type the brackets if you choose to specify these options or
arguments.

hypertext links When viewing this document online, clicking on chapter, section,
figure, table and page number references will display the
corresponding text. Clicking on Internet URLSs provided in blue type
will launch your web browser and display the web site. Clicking on
publication names and numbers in red type will display the
corresponding manual PDF, if accessible.

Related Publications

The following table lists Concurrent documentation for RedHawk Architect and the
components that can be installed using RedHawk Architect. Depending upon the
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document, they are available online on RedHawk Linux systems or from Concurrent’s
documentation web site at http://redhawk.ccur.com/docs.

RedHawk Architect Pub. Number
RedHawk Architect Release Notes 0898600
RedHawk Architect User’s Guide 0898601
RedHawk Linux

RedHawk Linux Release Notes 0898003
RedHawk Linux User’s Guide 0898004
RedHawk Linux FAQ N/A
NightSar Development Tools

NightView User’s Guide 0898395
NightTrace User’s Guide 0898398
NightProbe User’s Guide 0898465
NightTune User’s Guide 0898515
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1
Using RedHawk Architect

This chapter introduces you to the RedHawk Architect and provides instructions for its
use.

Introducing Architect

RedHawk Architect is an easy-to-use GUI interface for configuring, building and flashing
embedded solutions.

RedHawk Architect greatly simplifies the following tasks to create and maintain a runtime
and development environment for single board computers (SBCs):

* instaling custom configurations of the Red Hat® Enterprise Linux®
distribution
¢ instaling and configuring the RedHawk™ operating system
¢ instaling NightStar™ application devel opment tools
* maintaining and reconfiguring an SBC'sroot file system
With Architect, you choose the Linux and application modules that will be installed with
the RedHawk kernel. For example, select networking, web server, web browser, database,

X server, minimal or all packages. Architect allows the Linux file system to be customized
and minimized for embedded applications using flash memories as small as 2 GB.

Architect creates and processes a configuration file based upon your selections and
performs actual RPM package installation. It prompts you to insert the necessary
RedHawk, Red Hat and NightStar media depending upon the features selected.

A flashing tool is provided for installing RedHawk and your application image onto a
CPU board’s non-volatile memory.

Creating aroot File System for Embedded Target Boards

To create aroot file system that can be used on a single board computer, use RedHawk
Architect on a RedHawk Linux host system to perform the following steps:

1. Create an image by selecting the software to be installed and building the
image.

2. Configure the image.
3. Customize the image for your embedded application.

1-1
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4, Flash theimageto install it on your target boards.

These procedures are described in the sections that follow. The steps may be repeated to
change the image and/or flash it any number of times.

Running Architect

1-2

For instructions for installing RedHawk Architect, refer to the RedHawk Architect Release
Notes.

Architect must be run as the root user.
To run Architect, type architect at ashell prompt:
# architect

When Architect starts, a dialog appears presenting you with the option to start a new
session or load an existing session.

Dialog E]ﬁ

-

RedHawk Architect

Create a new session.
Open an existing session.

Close Close this dialog.

IhE
L

Figure 1-1 Opening RedHawk Architect Dialog

To start anew session, click onthe New... button. See* Creating a New Session” on page
1-3for details.

A session can be saved at any time and loaded later to continue work on the file system
image. To edit an existing session, click on the Open... button. See “Editing an Existing
Session” on page 1-22 for details.

When the Close button is clicked, the RedHawk Architect main window appears, as
shown in Figure 1-2.
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A RedHawk Architect E]@E]

File Help
= N N

4y Select Products

Package Views:

[Embedded RedHawk Package Groups |v]

l - Red Hat Fackages ~Package Groups

l - RedHawk l Show only packages matching: ]

l i l | Install | Name Size(KEB) Description |
J NightStar

% | Build Image

Configure Image

Customize Image

Flash Image

—Packages in Group

[ Select all packages in group]

| Install Name | Size(KB) Description |

Figure 1-2 RedHawk Architect Main Window

Your choices are:

* dtart a new session by clicking on the New Session icon © or selecting
New Session from the File menu along the top of the window. See
“Creating a New Session” on page 1-3 for details.

* edit an existing session by clicking on the Open Session icon = or
selecting Open Session in the File menu. See “Editing an Existing
Session” on page 1-22 for details.

Creating a New Session

An Architect session describes all decisions made about a particular file system image,
including:

* thetarget SBC
¢ which software should be installed
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* how the software should be configured

When you select the New... button from the opening Architect dialog, or the New
Session icon or New Session from the File menu along the top of the RedHawk
Architect main window, the Session Edit dialog, shown below, displays.

= Session Edit E]W

Target Board: | GE Fanuc V7865 |v]

—Target Board Options

Ram Size: [1 Gigabyte |v]
Compact Flash Size: [2 Gigabytes |v]
Serial Devices: | ttyS0 115200 M
Network Devices: [Eth3, eth2 |v]

| QK | [ Cancel l

Figure 1-3 Session Edit Dialog

This dialog enables you to define the target board and its various characteristics using the
fields described below.
Target Board

This dropdown is used to specify the target board. Currently, only the GE
Fanuc V7865 board is supported.

Ram Size

Select the size of RAM for your board from the dropdown.

Compact Flash Size

Select the size of the compact flash that matches your board from the
dropdown. Choices are 2, 3 and 4 GB.

Serial Devices

Make a selection from the dropdown based on the available serial
device(s). The board without an optional VME Rear Transmission Module
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(RTM) has one serial port available (ttyS0 115200). If aVME RTM is
attached, two seria ports are available (ttyS0 115200, ttyS1 115200).

Network Devices

Make a selection from the dropdown based on the available ethernet
port(s). The board without an optional VITA 41.3 RTM has two ethernet
ports (eth3, eth2). If the RTM is attached, two additional ethernet ports are
available (eth0 and ethl).

OK

Click on this button when all desired selections have been made. This
dialog closes and the RedHawk Architect main window is activated.

Cancel

Click on this button to cancel any changes made. The dialog closes and you
are returned to the RedHawk Architect main window.

Selecting Software to Install in the Image

To select the software to install in the file system image, click on Select Products from
the toolbox on the left side of the RedHawk Architect main window. This allows you
to select software from the following three groups:

¢ Red Hat Enterprise Linux 5.1 packages

* RedHawk 5.1 0OS

* NightStar RT

Some initial selections are made for you by default; e.g. the core RedHawk OS.

TheImage Size gauge at the top of the RedHawk Architect main window indicates
the approximate size the file system image will be when built. It also indicates the
percentage of the target board’s root device that will be consumed by the image.

Selecting Red Hat Packages

To select Red Hat Enterprise Linux packages for the file system image, click on the Red
Hat Packages selection from the Select Products toolbox.

Red Hat packages may be navigated by way of several “Package Views’. Select the
desired package view from the Package Views dropdown. The following views are
available and are described in the subsections that follow.

¢ Embedded RedHawk Package Groups
* RHELS5.1 Package Groups

¢ All Packages
¢ Selected Packages
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Using the Embedded RedHawk Package Groups View

File Help

=~ & d

4l Select Products

TheEmbedded RedHawk Package Groups view providesaview of some Red Hat
packages organized into groups. The groups of packages have been optimized for
embedded RedHawk systems and are meant to simplify the task of choosing packages for

common functionality. Thisview is shown in Figure 1-4.

Packages may be selected or deselected by choosing a package group in the upper pane
and then checking or un-checking packages in that group in the lower pane. All packages

may be selected with the Select all packages in group button.

The Undo button cancels out your last select or unselect operation.

RedHawk Architect

Target: GE Fanuc V7865 | Image Size: Using 1127 MB (559 o PN ELINTH)

Package Views:

{ g Red Hat Packages ‘ - Grouping of main packages used for RedHawk embedded systems

[Embedded RedHawk Package Groups |v|

{ & RedHawk

I Embedded RedHawk

{ J NightStar

Group Name | Description
I Minimal The minimum set of packages required for an embedded RedHawk system

% | Build Image

Configure Image

Customize Image

Flash Image

Networking IPv6 IPv6 network utilities for an embedded RedHawk system.
Web Server Apache web server for an embedded RedHawk system.
Web Browser  Firefox web browser for an embedded RedHawk system.

= Database MySQL database for an embedded RedHawk system

NFS Network File System for an embedded RedHawk system.

Networking Netwaork utilities for an embedded RedHawk system. :

[

~Packages in Group

\ -+ Select all packages in group 4 Undo

| Install | Name | Size(KB) | Description |~
[] dhcp-3.05-7.el5.i386 2176 DHCP (Dynamic Host Configuration Protocol) server and r...
] .Ftp—o.l?—33.fc6.i386 .83 The standard UNIX FTP (File Transfer Protocol) client.

| |0pen55h-4.3p2-24.e|5 1386 .725 The OpenSSH implementation of SSH protocol versions 1...

T openssh-askpass-4.3p2-24.el5.i386 |9 A passphrase dialog for OpenSsH and X
openssh-clients-4.3p2-24.el5.i386 .839 The OpensSH client applications

| openssh-server-4.3p2-24.el5.i386 .450 The OpenSSH server daemon E

Figure 1-4 Selecting Red Hat Packages, Embedded RedHawk Package

Groups View
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Using the RHEL5.1 Package Groups View

TheRHELS5.1 Package Groups view providesaview of Red Hat packages organized
in a hierarchy of groups. The package group hierachy is the standard Red Hat package
group hierachy. Thisview is shown in Figure 1-5.

Packages may be selected or deselected by choosing a package group in the upper pane
and then checking or un-checking packages in that group in the lower pane. All packages
may be selected with the Select all packages in group button.

The Undo button cancels out your last select or unselect operation.

RedHawk Architect

File Help

o /4 |3 [  Target GEFanuc v7865 | Image Size Using 1127 MB (55% o F Xl LI )]

4l Select Products

Package Views:

[RHEL‘E 1 Package Groups |v|
l g Red Hat Packages ‘ ~Redhat grouping of packages
l & RedHawk ‘ Desktop Environments | Applications l Development | Servers | Virtualization | Base System | Langua{:lb—
Group Name | Description et
l ) NightStar ‘ Authoring and Publishing | These tools allow you to create documentation in the DocBook format and convertt...
Office/Productivity .The applications include office suites, PDF viewers, and more.
Sound and Video .From CD recording to playing audio CDs and multimedia files, this package group all...
S Hild e Eclipse :The Eclipse Integrated Development Environment. L]
Editors sometimes called text editors, these are programs that allow you to create and edi...
Customize Image o Games and Entertainment Various ways to relax and spend your free time. =

Flash Image

—Packages in Group

[ i Select all packages in groupl “ Undo

Install | Name | Size(KB) | Description |
[] gnuplot-4.0.0-12.i386 3648 A program for plotting mathematical expressions and data.
] .Iam-?.1.2-8.fc6 386 .2836 .The LAM (Local Area Multicomputer) programming environment.
J .Iapack-3.0-3?.e|5.i386.5304 .The LAPACK libraries for numerical linear algebra
[] pvm-3.4.5-7fc6.1.i386 6641 Libraries for distributed computing.
[ .units-l 85-1.2.2i386 .262 .A utility for converting amounts from one unit to another.

Figure 1-5 Selecting Red Hat Packages, RHEL 5.1 Package Groups View

Using the All Packages View

The All Packages view, as shown in Figure 1-6, provides a linear list of all Red Hat
packages.
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A RedHawk Architect —I[a][x]
File Help
= Lj LJ Target: GE Fanuc V7865  Image Size: [ f 2 Gigabytes) l
4 Select Products Package Views:
[AII Packages |v]
l \‘ﬁ) Red Hat Packages ~List of all packages available
l k RedHawk l Show only packages matching:
l 1 Nightstar l Install | Name | Size(KB) | Description - |
[[] Deployment_Guide-as-IN-5.1.0-11.noarch 9979 Deployment Guide !
[] Deployment_Guide-bn-IN-5.1.0-11.noarch 9979 Deployment Guide
& Build Image [] Deployment_Guide-de-DE-5.1.0-11.noarch 10120 Deployment Guide
3 [] Deployment_Guide-en-Us-5.1.0-11.noarch 9980 Deployment Guide
Configure Image
[[] Deployment_Guide-es-ES-5.1.0-11.ncarch 10147 Deployment Guide
Customize Image
[] Deployment_Guide-fr-FR-5.1.0-11.noarch 10246 Deployment Guide
Flash Image
[] Deployment_Guide-gu-IN-5.1.0-11.noarch 9979 Deployment Guide
[] Deployment_Guide-hi-IN-5.1.0-11.noarch 9979 Deployment Guide
[[] Deployment_Guide-it-IT-5.1.0-11.noarch 9598 Deployment Guide
[] Deployment_Guide-ja-JP-5.1.0-11.nearch 10319 Deployment Guide
[] Deployment_Guide-kn-IN-5.1.0-11.noarch 9979 Deployment Guide
[] Deployment_Guide-ko-KR-5.1.0-11.noarch 10031 Deployment Guide
[] Deployment_Guide-ml-IN-5.1.0-11.noarch 9979 Deployment Guide
[] Deployment_Guide-mrIN-5.1.0-11.noarch 9979 Deployment Guide
[] Deployment_Guide-or-IN-5.1.0-11.noarch 9979 Deployment Guide @

Figure 1-6 Selecting Red Hat Packages, All Packages View

Packages may be selected or deselected from thislist. The Show only packages
matching box allows you to search for packages by name.

The Undo button cancels out your last select or unselect operation.
Using the Selected Packages View

The Selected Packages view, as shown in Figure 1-7, provides alinear list of al Red
Hat packages that are currently selected for installation.

1-8
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A RedHawk Architect E]@E]
File Help
IE ] Lj LJ Target: GE Fanuc V7865 | Image Size: [ 'f 2 Gigabytes) l
4 Select Products Package Views:
[Selected Packages |~

~List of packages currently selected for installation

l & RedHawk l & Undo [%] Show required packages Show only packages matching: [:]

-

l \:a)’ Red Hat Packages

l 1 Nightstar l Install | Package Name | Size(KB) | Description

[] |GConf2-2.14.0-9.el5.i386 4754 A process-transparent configuration system !

MAKEDEV-3.23-1.2.i386 641 A program used for creating device files in /dev.

& Build Image ORBIit2-2.14 3-4.el5.i386 726 A high-performance CORBA Object Request Broker

R SysVinit-2.86-14.i386 189 Programs which control basic system processes.
Configure Image

alsa-lib-1.0.14-1.rc4 el5.i386 1109 The Advanced Linux Sound Architecture (ALSA) library.
Customize Image

at-3.1.8-82.fc6.i386 77 Job spoaling tools.

Flash Image
at-spi-1.7.11-2 fc6.i386 897 Assistive Technology Service Provider Interface

atk-1.12.2-1 fc6.i386 855 Interfaces for accessibility support

audiofile-0.2.6-5.i386 255 A library for accessing various audio file formats.
audit-libs-1.5.5-7 el5.i386 115 Dynamic library for libaudit
audit-libs-python-1.5.5-7.el5.1386 235 Python bindings for libaudit

authconfig-5.3.12-2.el5.i386 1553 Command line tool for setting up authentication fromn...
avahi-0.6.16-1.el5.i386 683 Local network service discovery

avahi-glib-0.6.16-1.el5.i386 9 Glib libraries for avahi

sEEEEEREEREEREE

©

basesystem-8.0-5.1.1.noarch 0 The skeleton package which defines a simple Red Hat Li... @

Figure 1-7 Selecting Red Hat Packages, Selected Packages View

Packages may be deselected from this list. The Show only packages matching box
allows you to search for packages by name.

To include the required packages in the list, check the Show required packages
checkbox. When this box is unchecked, only the optional packages are shown.

The Undo button cancels out your last select or unselect operation.

Selecting RedHawk OS Options

To select RedHawk Linux OS and kernels for the file system image, click on the
RedHawk selection from the Select Products toolbox. The RedHawk page, shown in
Figure 1-8, displays.
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A RedHawk Architect

File Help

. /= (5 [G]  Terget: GEFanuc V7865  Image Size: Using 1127 MB (55% o X LIS L))

4 Select Products

’ ﬁ Red Hat Packages ‘
\ RedHawk

’ ) NightStar ‘

~RedHawk Products to Install

% | Build Image | Core 05

Configure Image

Customize Image _ RedHawk Kermel To Use
Flash Image [ standard

[ Trace

] Debug

Figure 1-8 Selecting RedHawk Options

The Core OS product is required and cannot be deselected. Other RedHawk products
will be available in future releases.

Select which RedHawk kernel(s) to install by checking the appropriate checkbox(es):
Standard, Trace and/or Debug.

Selecting NightStar RT Options

To select NightStar RT tools for the image, click on the NightStar selection from the
Select Products toolbox. The NightStar page, shown in Figure 1-9, displays.

1-10
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RedHawk Architect

File Help

A d o

4 Select Products

Target: GE Fanuc V7865 | Image Size: | Using 1127 MB(55% o @ X[-ELIITH)]

’ \-f Red Hat Packages ‘

’ & RedHawk

|

) NightStar

—® Install NightStar RT —

@ Servers Only

[%] NightProbe
[%] NightTrace
[%] NightTune
[%] NightView

() Full Tool Set

% | Build Image

Configure Image

Customize Image

Flash Image

i

)’1

NightStar

¢ - Application speed conditions and ignore counts

NightProbe™ Data Monitor

- Unintrusive sampling and recording of program data

- Synchronous and asynchronous data capture

- Flexible data display features

- Program data modification

- Sampling, recording and replaying APls

NightTrace™ Event Analyzer

- Synchronized graphical or text display of all system activity
- User-defined event logging

- 05 event logging including system calls, interrupts and exceptions
- Precision time-stamping of all events

- Powerful data analysis APl

- Function call and parameter tracing

NightTune™ Performance Tuner

- Dynamic display of system and application performance

- Monitoring of CPU use, memory utilization and network operation

- Interactive control of CPUs, priorities, policies, shielding and interrupts

- Dynamic CPU affinity control for processes, threads and interrupts

- Detailed process and thread information

NightView™ Source-level Debugger

- Multi-system, multi-process and multi-thread debugging via single interface

- Hot patches including breakpoints, patchpoints, monitorpoints and watchpoints

- Dynamic memory (heap) debugging
- Modification and display of variables during execution

Figure 1-9 Selecting NightStar Tools

Each NightStar tool is described in the righthand side of the page.

Click on the Servers Only radio button to indicate that only NightStar servers are to be
installed in the image. You may select individual servers from the list by clicking on the
checkboxes for each tool.

Click on the Full Tool Set radio button to indicate that NightStar servers and clients are
to beinstalled in the image.

Building an Image

To build the file system image by installing the selected software, select Build Image
from the toolbox on the left side of the RedHawk Architect main window. The Build
Image dialog shown in Figure 1-10 displays.

1-11
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RedHawk Architect

File Help

S d u Target: GE Fanuc V7865 | Image Size: Using 1127 ME (55900 @ A-L1 3T |
4 Select Products ~Build Options

% | Build Image

Target Directory: [,"home:‘images l ‘ Change...
|

£ i ‘ Image Name: Ifanuc-l‘

‘ﬁ Launch Build..

Configure Image

Customize Image

Flash Image

Figure 1-10 Build Image Dialog
Choose a directory in which to build the file system image and enter it in theTarget
Directory field, or click on the Change button to display afile browser from which to
choose.
NOTE
Do not use /tmp as the the image file directory. Packages like

“tmpwatch” might remove files that have not been accessed in a
certain number of days, thereby sabotaging the image directory.

Choose aname for the file system image and enter it in the Image Name field.
NOTE
Make sure that the directory you specify has enough free disk

space to hold one or more file system images, each of which can
be several gigabytesin size.

1-12
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Click on the Launch Build button to begin the build process.

Dialogs are presented to guide you through the process of installing the software into the
image. For example, you will be prompted to insert various DVD or CD media, as shown
in Figure 1-11. Follow the directions to load the media, then click OK to begin.

BUILD INFORMATION

Figure 1-11 Build Prompt to Insert RHEL Media

When OK is selected, the RHEL installation begins. The Build Image screen overlays
the RedHawk Architect main window and tracks the progress, as shown in Figure
1-12.

Clicking Abort at any time in the build process aborts the build. A confirmation message
then displays and you must click on the Close button to close the message box and
reactivate the RedHawk Architect main window.

x|

|, Build Image

\? Image target directory: /home/fimages/fanuc-1

Current Progress

Creating RHEL 5.1 image

initscripts-8.45.17 EL-1

Overall Progress

TIRNNNN] |

Fetching RHEL packages from media... COMPLETED
Creating initial RHEL image

Figure 1-12 Status of RHEL Installation

A progress bar at the top of the Build Image screen shows the progress of the RHEL
installation from the media.

1-13
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1-14

A progress bar in the lower half of the screen tracks the progress of the complete build
process, including installation of remaining packages. The progress bar can be changed to
an “error log” using the View dropdown. Status messages display in the lower pane.

View

When Status is selected, the Overall Progress displays as a progress bar.
When Error Log is selected, overall progress displays as an error log,
which shows any error messages generated by the build process.
Regardless of the View setting, critical error messages result in pop-up
error dialogs with which you can interact.

Abort

Click on this button to abort the build. A confirmation message then
displays and you must click on the Close button to close the message box
and reactivate the RedHawk Architect main window.

Close

Once the build is completed or aborted, click on the Close button to close
the Build Image screen and reactivate the RedHawk Architect main
window.

When the RHEL installation is complete, the dialog shown in Figure 1-13 appears.

-

v

i i Please insert the RedHawk Linux O5 (Version 5.1) CD.

BUILD INFORMATION [x]]

| oK H Abort ]

Figure 1-13 Build Prompt to Insert RedHawk Media

Load the RedHawk Linux media, then click OK. The RedHawk installation begins and

the Build Image screen tracks the progress, as shown in Figure 1-14.
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Build Image

x|

\? Image target directory: /home/fimages/fanuc-1

Current Progress

Installing RedHawk Linux OS (Version 5.1)

ccur-crash-4.0-6.2.20080414.i386.rpm: OK [=]
ccur-docs-5.1-20080414.i386.rpm: OK

ccur-gather-5.1-20080414.i386.rpm: OK

ccur-glibc-2.5-18.20080414 .1686.rpm: OK

ccur-hyper-5.1-20080414.i386.rpm: OK

ccur-kernel-5.1-20080414.i1686.rpm: OK

Overall Progress

I BBRNRRBRRNINAY

Fetching RHEL packages from media... COMPLETED
Creating initial RHEL image... COMPLETED
Installing RedHawk OS...

Figure 1-14 Status of RedHawk Installation

When the RedHawk installation is complete, the dialog shown in Figure 1-15 appears.

-

* BUILD INFORMATION [x]]

@ Please insert the NightStar RT (Version 4.1-5R3 or newer) CD.

| oK |[ Abort l

Figure 1-15 Build Prompt to Insert NightStar Media

L oad the NightStar media, then click OK to begin. The NightStar installation begins and
the Build Image screen tracks the progress, as shown in Figure 1-16.
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|, Build Image

x|

\? Image target directory: /home/images/fanuc-1

Current Progress

Installing NightStar RT

Please contact Concurrent tech support if you had any problems

during this install (support@ccur.com or 1-800-245-6453).

‘NightStar RT Server' Installation...

Preparing... HEHBHHHLRHEH B R EH LB RH B RSB LB RF B IR I BRI BB FRRERE

Overall Progress

View: [sas |

AERRRRRNRRRRNRRNRNNNT]

Fetching RHEL packages from media... COMPLETED
Creating initial RHEL image... COMPLETED

Installing RedHawk OS... COMPLETED

Installing NightStar RT...

Figure 1-16 Status of NightStar Installation

When all software is installed, the completion message shown in Figure 1-17 appears.

Click OK to close the Build Image screen and reactivate the RedHawk Architect
main window.

|" = BUILD STATUS

@ The build completed successfully

Figure 1-17 Build Completed Successfully Message

Configuring an Image

To configure the file system image, select Configure Image from the toolbox on the | eft

side of the RedHawk Architect main window. This allows you to configure the
following three groups:

1-16



Using RedHawk Architect

¢ General Settings
* Console
* Networking

Some initial selections are made for you by default.

Configuring General Settings

To configure time zone, root password and default system run level for the file system
image, click on General Settings from the Configure Image toolbox. The General
Settings configuration dialog appears, as shown in Figure 1-18.

RedHawk Architect

File Help

4 Select Products

% | Build Image

-, Configure Image

1!
’ & General Settings ‘

‘ |i| Console ‘

’ Q Networking ‘
=

[ Customize Image

_ Flash Image

== | Target: GE Fanuc V7865 | Image Size: Using 1127 MB (55% o P XL )

—General Settings

~Time Zone

| America/New York Al

(%] System clock uses UTC

~Root Password

Password: [eececen |

Confirm Password: [ (212122 1] l

~Run-level

System Run-level: | 1 v|

-, Apply general settings...

Figure 1-18 General Settings Configuration Dialog

Inthe Time Zone section, select the proper time zone for your location from the
dropdown. Click in the checkbox to indicate if your system clock uses UTC.

Inthe Root Password section, enter the root password in the Password field. Reenter
itin the Confirm Password field.
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Inthe Run Level section, select the desired default run level from the dropdown.

When all entries are complete, click on the Apply general settings... button to apply
the settings to the image.

Configuring a Console

To configure a serial console for the file system image, click on Console from the
Configure Image toolbox. The Console Configuration dialog appears, as shown in
Figure 1-19.

RedHawk Architect

File Help

T | d L_‘ Target: GE Fanuc V7865 Image Size: LR RRE AL 2 Gigabytes)
4 Select Products _ -Console Configuration
% | Build Image | Configure a serial console —
-, Configure Image Serial Port: |tty50 ~|

Baud Rate: (115200 ||

L
l _!a General Settings

|i‘ Console

l Q Networking
=

[+ Customize Image

. Flash Image

“, Apply console settings...

Figure 1-19 Console Configuration Dialog

Click onthe Configure a serial console checkbox to activate the fields that define the
port and baud rate for the console.

Select aport from the Serial Port dropdown.

Select abaud rate from the Baud Rate dropdown.
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When all selections have been made, click on the Apply console settings... button to
apply the settings to the image.

Configuring Networking

To configure networking for the file system image, click on Networking from the
Configure Image toolbox. The Network Configuration dialog appears, as shown in
Figure 1-20.

RedHawk Architect

File Help

’ || Console

2 d h_] Target: GE Fanuc V7865 | Image Size: USing 1127 MB (5550 X ELMER)

4l Select Products _ ~Network Configuration

% | Build Image ~Devices

-, Configure Image |Edit Device Configuration

1 #1 Enabled On Boot @ Device |& IPv4 Address |\i’,'“| Netmask ‘
!ﬂ General Settings

1 Yes eth3 DHCP DHCP
2 Yes eth2 DHCP DHCP

|

Q Networking

[ Customize Image

) Flash Image

~Miscellaneous Settings

Default Gateway: | . . . |

Domains I
Secondary DNS Server:

—Hostname

/@ Obtain automatically via DHCP

) Manually :} (e.g. host.domain.com)

= Apply network settings...

Figure 1-20 Network Configuration Dialog

All available network devices arelisted in the Devices section.

To configure a particular network device, click on the device to select it, then click on the
Edit Device Configuration button. The Configure Network Device dialog shown
in Figure 1-21 displays.
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1-20

Configure Network Device

“El eth3=Intel Corporation 82571EB Gigabit Ethernet Controller (rev 06)

......

IP Address Configuration

() Dynamic IP Configuration (DHCP)

@ Manual Configuration

IP Address Netmask

f

[ o ) [ oma |

Figure 1-21 Configure Network Device Dialog

The selected network device is displayed at the top of the dialog.

Click onthe Enabled On Boot checkbox to enable/disable the device automatically on
boot.

Select Dynamic or Manual |P address configuration by clicking on the appropriate radio
button. For manual configurations, enter the 1P address and netmask in the appropriate
fields.

Click on OK to apply the settings to the image and close the dialog. Click Cancel to
cancel changes.

On the Network Configuration dialog (Figure 1-20) in the Miscellaneous
Settings area, supply the default gateway, domains, primary and secondary DNS server
addresses in the appropriate fields.

In the Hosthname area, select whether the hosthame is configured automatically or
provided manually by selecting the appropriate fields.

When all selections have been made, click onthe Apply networking settings... button
to apply the settings to the image.
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Customizing an Image

To further customize the file system image, select Customize Image from the toolbox

on the left side of the RedHawk Architect main window. The dialog shown in Figure
1-22 displays.

AN RedHawk Architect
File Help

. /4 |2 L]  Target: GEFanuc V7865 Image Size: Using 1127 MB (55900 FXT RN EE)

4 Select Products

—Chroot Shell

# | Build Image o Run @ chroot shell in a terminal to customize the image.

-, Configure Image Terminal:

| Customize Image Run...
‘ Shells ‘

.. Flash Image

Figure 1-22 Customize Image Dialog

From this toolbox you can open a“chroot” shell in aterminal window. Select the type of

terminal from the dropdown and click on the Run button. A terminal screen opens, as
shown in Figure 1-23.
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Architect chroot shell

File Edit View Terminal Tabs Help

Entering embedded image configuration shell. =
Exit the shell when you are finished.

embedded-image#

Figure 1-23 chroot Shell

This provides a shell with the root directory being the file system image directory. All
changes made to system files (including software installed or removed) will be done in the
file system image directory only. The host's root file system will not be affected.

Exit the shell when changes are compl ete.

Editing an Existing Session

1-22

A session can be saved at any time and loaded later to continue work on a file system
image.

To save the current session click on the Save Session icon = or on Save Session in
the File menu. Selecting the Save Asicon 4 or Save Session As in the File menu
displays afile selection dialog.

To load an existing session, click on the Open Sessionicon % or on Open Session in
the File menu. You may aso click on the Open... button from the opening dialog when
Architect first starts.
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Flashing an Image

You can copy aroot file system image created with Architect to a compact flash.

The Flash Image option from the toolbox on the RedHawk Architect main window
does not function at this time. However, a utility is available to copy aroot file system
image onto a compact flash that is connected directly to the host machine, either via a
USB-to-CompactFl ash adapter or an IDE-to-CompactFlash adapter (these can be bought
inexpensively at many retail storesthat sell computer accessories).

To use thistool run:
/usr/bin/em-flasher image directory
Be aware of the following em- £1lasher limitations:

1. Only one USB/flash adapter can be connected to the host.

2. em-flasher assumes the entire CompactFlash or any other flash
medium as one partition.

3. IDE/SATA CompactFlash adapters are not recognized automatically and
you must enter the device name when prompted.

Updating Software with NUU

Concurrent’s Network Update Utility (NUU) is a graphical user interface which allows
you to install, update and remove RPM packages on a system. The packages are
downloaded from a remote yum repository. For more information about NUU, see
http://redhawk.ccur.com/updates/index.html.

NUU may be used to maintain the softwareinstalled in afile system image. NUU is an X-
based application. Running X applications under a chroot shell requires the following
specia X configuration on the host system:

1. Runthe gdmsetup command and uncheck the box that reads “Deny TCP
connectionsto Xserver” under the “ Security” tab.

# gdmsetup

2. Restart the X server:
# killall Xorg

3. Run the command:
# xhost +
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